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Sinopsis 
 

 Dado que estamos viviendo en una sociedad en donde todo gira en torno a la tecnología 

la demanda laboral por expertos en estas áreas está aumentando. A la misma vez que aumenta la 

demanda por profesionales en las áreas de tecnología, disminuye la cantidad de estudiantes que 

decide elegir una carrera en las áreas de ciencia, tecnología, ingeniería y matemáticas (STEM). 

Por consiguiente, es una tarea esencial el aumentar la cantidad de estudiantes que eligen una 

carrera profesional en alguna de las áreas antes mencionadas para poder resolver este problema 

[1]. Como una posible solución para esto el grupo de investigación “Embedded” ha diseñado un 

programa de alcance para aumentar el interés de estudiantes de escuelas superior en las áreas de 

ciencia, tecnología, ingeniería y matemáticas. El mismo se llevará a cabo utilizando juegos de 

carnaval como método de aprendizaje interactivo. Ha sido comprobado que al realizar 

actividades prácticas e interactivas es uno de los métodos más efectivos para exponer estudiantes 

a oportunidades en las áreas de ciencia, tecnología, ingeniería y matemáticas. En este manual se 

discutirá el proceso adecuado para la configuración y diseño del juego skeeball. 
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Objetivos 
 

● Aumentar el conocimiento e interés en ingeniería eléctrica y computadoras (ECE) en 

estudiantes de escuela superior mediante la construcción de juegos interactivos. 

● Lograr que los estudiantes puedan completar el juego en el periodo establecido utilizando 

el manual de instrucciones. 

● Por medio de un plan de evaluación, identificar y medir el conocimiento e interés 

adquirido mediante la actividad. 

● Demostrar principios y conceptos básicos de sistemas integrados, circuitos, programación 

y electrónica.  
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Introducción 
 

A través de los años la necesidad de avances tecnológicos ha aumentado 

exponencialmente; por lo cual, se urge una mayor cantidad de profesionales enfocados en las 

áreas de ciencia, tecnología, ingeniería y matemáticas (STEM). El grupo de investigación 

“Embedded Research Group” de la Universidad de Puerto Rico Recinto de Mayagüez se propone 

diseñar e implementar un programa de alcance que pueda incrementar la cantidad de estudiantes 

que escogen ser profesionales en las áreas ya mencionadas. Se plantea como solución recurrir a 

juegos de carnaval comunes donde los estudiantes puedan aprender los conceptos básicos de 

programación, ensamblaje de circuitos y sistemas integrados mientras juegan. De esta manera, 

podemos captar su atención con mayor facilidad. El grupo se subdivide en diferentes tipos de 

juegos por lo cual éste módulo en específico se enfoca en el juego de skeeball.  

Skeeball es un juego que consiste en rodar una bola por una rampa con el propósito de 

que caiga en unas aperturas en específicas.  Estas aperturas tienen una puntuación definida con 

fin de obtener la mayor cantidad de puntos posibles dentro del límite de tiempo establecido. El 

juego se originó en el 1909 por J. Dickenson Estes como un regalo de cumpleaños para su hijo 

de ocho años y lo llamo “Box Ball”. En su modelo original tenía tres aperturas y se utilizaban 

bolas de metal. Sin embargo, a través de los años se fue modificando hasta lo que conocemos 

hoy en día. El modelo que diseñaremos es uno con cinco aperturas y utilizando bolas de tenis de 

mesa. Se usarán materiales fáciles de adquirir, reciclables, eco-amigables y de bajo costo para 

beneficios de los estudiantes.  
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Conceptos Básicos 
 

A. Componentes: 

 

Componente Descripción Figura 

Pantalla de 7 

segmentos 

Pantalla de 7 segmentos que nos 

permite mostrar números decimales. 

En nuestro caso se utilizará para 

mostrar el tiempo y puntuación al 

usuario. 

 

Sensores infrarrojos 

Estos son sensores de luz que 

detectan un largo de onda específico 

en el espectro infrarojo. Con esto se 

puede detectar la presencia de un 

objeto en proximidad. 

 

 

Arduino UNO R3 

El Arduino UNO R3 es un 

microcontrolador, o en otras palabras 

un circuito integrado programable y 

capáz de ejecutar órdenes grabadas 

en su memoria. En palabras simples, 

es el cerebro del juego que se 

encarga de tomar todas las decisiones 

referentes a la puntuación y tiempo.  

Botón de pulso 

Botón con un mecanísmo simple de 

pulso y que permite alguna máquina 

continuar llevando a cabo un 

proceso. En nuestro caso nos permite 

comenzar el juego. 
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Cable USB tipo A/B 

Cable utilizada para conectar el 

Arduino UNO R3 a la computadora 

para poderlo programar. Este 

usualmente está incluido con el 

Arduino UNO R3. 

 

Resistor 

El resistor es un componente 

eléctrico de dos terminales, positivo 

(+) y negativo (-), que es utilizado 

para reducir el flujo de corriente o 

dividir voltages. 

 

Cables 

Macho/Macho 

Estos cables nos permiten unir los 

componentes electronicos como el 

boton, microcontrolador, pantallas de 

7 segmentos y resistor al tablero de 

circuitos. 

 

Cables 

Macho/Hembra 

Estos cables nos permiten unir los 

componentes electronicos como el 

boton, microcontrolador, pantallas de 

7 segmentos y resistor al tablero de 

circuitos. 

 

Tablero de circuitos 

Tablero que se utiliza para realizar 

prototipos eléctronicos. Nos permite 

conectar varios componentes 

eléctricos en un solo lugar. 

 

Tabla 1: Lista de componentes eléctricos 
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B. Funcionamiento del tablero de circuitos: 

 

El tablero de circuítos, como 

se muestra en la ilustración 1, es 

utilizado para conectar múltiples 

componentes eléctricos en un solo 

lugar. Este funciona como la imagen 

lo ilustra, las columnas A, B, C, D y 

E estan interconectadas 

horizontalmente. Sin embargo, los 

carriles de alimentación de ambos 

lados estan interconectados 

verticalmente. Esto significa que el 

carríl entero se comporta como un 

solo nodo y cualquier componente 

que se conecte en ese carríl estara 

conectado al resto de los 

componentes en el carríl. De la 

misma manera ocurre en las 

columnas A, B, C, D y E pero esta 

vez horizontalmente. 

En la siguiente página se 

muestran ejemplos de como se deben 

conectar los componentes en el 

tablero y como no se deben conectar. 
 

Ilustración 1: Tablero de circuitos 

 

 

 

 

 

 

 

 

 

 

 



10 | P a g e  

 Ejemplos de como se deben conectar los componentes en el tablero de circuitos: 

Como SI se deben conectar Como NO se deben conectar 

  

  

  

 

Tabla 2: Lista de componentes eléctricos 
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Materiales 
 

A. Cuerpo: 

 

Para el cuerpo todos los materiales necesarios se sugiere que sean reciclables y fácil de 

conseguir. Si es este el caso, lo único que se necesita es cartón, cartulina, madera, pega 

caliente y cinta adhesiva. En el ejemplo que se demuestra en las fotos y se describe en la 

metodología se utilizan materiales de mejor calidad, pero para una versión más 

económica solo hay que sustituir los materiales mencionados. 

 

B. Circuito Eléctrico: 

 

 

Tabla 3: Lista de componentes eléctricos 

 

 

 

 

Esquemático y Diagrama de Bloque 
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A. Esquemático: 

 

Un esquemático consiste de una representación de los elementos existentes en un 

sistema utilizando símbolos de los elementos o componentes en lugar de imágenes 

realisticas de ellos. Esto nos facilíta a la hora de montar un circuíto ya que es una 

herramienta simple y se puede replicar en vida real. Esta herramienta visual es utilizada 

en muchos campos y no sólo en electrónica. Por ejemplo, imagínese un esquemático de 

las carreteras de una ciudad o mapa de transito. Utiliza componentes abstractos y 

símbolos para identificar las vías, interecciones y carreteras. En la siguiente ilustración se 

muestra el esquemático que se utilizó para construir el juego Skeeball. 

 

Ilustración 2: Esquemático del Sistema 
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B. Diagrama de Bloque: 

 

En el caso del diagrama de bloque, este consiste de representar algún sistema por 

medio de bloques y conectado con líneas. Esta simple herramienta nos permite visualizar 

el sistema e identificar el límite o “boundary” del sistema al mostrarnos las entradas y 

salidas del mismo. En la siguiente ilustración se muestra el diagrama de bloque que se 

utilizó para construir el juego Skeeball. 

 

 

Ilustración 3: Diagrama de bloque del sistema 
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Metodología 
 

A. Configuración de la Caja: 

 

A continuación se muestra el ensamblaje paso a paso, las dimensiones del mismo dependen de 

cuán grande el usuario quiera su juego o el espacio disponible. Los instructores proveerán las 

dimensiones específicas para los estudiantes antes del taller.  
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Pas

o 

Descripción Ilustración 

1 

En este paso se tiene la base del juego con 

las dimensiones que le dará el instructor 

durante la actividad. 

 

2 

Luego de tener la base del juego, se corta 

una pieza de la forma en que se muestra en 

la figura con las dimensiones especificacas 

por el instructor. Esta pieza forma una de 

las paredes del juego. 
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3 

Con pega caliente adjunta la pieza #2 y #3 

a los extremos largos de la pieza número 

uno. De tal manera que las piezas parezcan 

una rampa como se ilustra. 

 

4 

Agrega ahora la pieza número cuatro al 

extremo alto de la pieza echa en el paso 

anterior. 
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5 

Para que las esferas puedan regresar a su 

origen y el jugador pueda recogerlas, se 

coloca la tabla número cinco de tal manera 

que su inclinación es parecida a la de la 

pieza número dos/tres. Pero por dentro de 

la caja conectando la figura uno con la 

cuatro. Esta tiene que ser removible y dado 

a esto se coloca utilizando velcro en sus 

extremos. 

 

6 

De manera similar con cinta adhesiva doble 

cara se pega la pieza número seis. Esta 

conecta en un extremo con la pieza número 

cinco y va cruzada hasta el otro extremo de 

la tabla sobre la figura uno. No se lleva 

completamente hasta el otro extremo dado 

a que se deja un espacio para que la esfera 

pueda cruzar con facilidad. El propósito de 

esto es guiar las esferas una vez tiradas 

hasta la canasta donde el jugador estará 

esperando.  
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7 

Pega la pieza número siete para tapar el 

interior del juego y poder darle soporte. 

Note que la altura de esta pieza es menor 

que la pieza #2 y #3 ya que luego se pondrá 

la rampa a un cierto grado de inclinación. 

 

8 

Coloca la pieza número ocho en forma 

paralela con la pieza número uno y 

conectando con la parte plana de las piezas 

dos/tres. Esta será por donde las esferas 

rodaran. Se debe tener en mente que esta 

pieza debe tener una inclinación pequeña 

para que la bola obtenga una mayor 

elevación cuando es tirada. 
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9 

Para poder trabajar en el interior de la caja 

se tiene que pegar dos pedazos de madera 

que van a trabajar como rieles para sujetar 

la pieza número nueve en posición. Estos 

pedazos de madera se adjuntaran a los 

extremos interiores de las piezas dos y tres 

mientras con velcro se anexa a la pieza 

número ocho. De esta manera se puede 

remover completamente. 

 

10 

Con tela o utilizando el mismo material del 

“D-Board” se debe hacer algún tipo de 

canasta para recoger las bolas con mayor 

facilidad, pero esto es opcional al igual que 

alguna otra decoración. 
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11 

Para evitar que las bolas se salgan de la 

tabla de juego se debe rodear la caja con 

acrílico o cartulina. 

 

 

Tabla 3: Explicación paso a paso 
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B. Configuración del Circuito Eléctrico: 

 

1. Para el inicio del juego, necesitamos un botón con el objetivo que la partida no 

comience hasta que el botón sea presionado. Para lograr esto, es necesario que el 

microcontrolador haga lecturas al botón, por lo que se procederá a conectar el botón a 

+5V en un extremo, mientras que el otro se conecta a un resistor “Pull Up” (El valor 

de este resistor debe ser de unos 220 Ohmios). El extremo restante del resistor debe 

estar conectado a GND y al pin digital #7. A continuación se muestran imágenes de la 

conexión y la caja. 

 

 

 

Ilustración 4: Conexión del circuíto 
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Ilustración 5: Conexión en la caja 

2. Una vez instalado el botón, se procede a la instalación de los sensores infrarrojos 

“Break Beam” los que detectarán cuando el balón pase a través de un agujero. Estos 

sensores constan de dos piezas tal como se muestra a continuación. 

 

 

Ilustración 6: Sensores infrarojos 

3. Para instalar el sensor se procede a hacer las conexiones de 5V y GND de ambas 

piezas, mientras que el receptor se conecta al pin digital #8 tal y como se muestra en 

la siguiente imagen. 
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Ilustración 7: Conexión de los sensores 

 

4. Repita el paso #3 para el resto de los sensores. 

 

 

Ilustración 8: Conexión del restante de los sensores 
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5. A continuación, se instalarán las pantallas de 7 segmentos. Se utilizarán dos pantallas, 

siendo la primera para marcar la puntuación y la otra para marcar el tiempo restante. 

A continuación, la imagen muestra la pantalla y la conexión que debe tener la misma. 

 

Ilustración 9: Pantalla con sus respectivas conexiones 

6. Es importante verificar que una de las dos pantallas tenga una soldadura en la 

resistencia A0 en la parte posterior tal como se muestra en la siguiente imagen. De no 

tenerla, seguir las instrucciones mostradas en la foto. 

 

Ilustración 10: Vista desde la parte de atrás de la pantalla 
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7. La conexión de las pantallas se da por medio de IIC. Para la misma se conectan los 

primeros dos pines (IO y 5V) a la salida de 5V del microcontrolador, mientras que el 

GND se conecta a negativo. Los 2 pines restantes son para la comunicación IIC y se 

procederá a conectar a los pines análogos A4 y A5 tal como muestra la siguiente 

imagen.  

 

 

Ilustración 11: Conexión de las pantallas al Arduino 
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C. Configuración del Código: 

 

1. Descargue e instale el Arduino IDE de la siguiente página:  

● https://www.arduino.cc/en/Main/Software 

 

2. Conecte la tarjeta Arduino UNO a la computadora por medio del cable USB 

estandar AB. 

 

3. Verifique que el programa esté utilizando la tarjeta Arduino UNO y no otra. Vaya 

a Tools -> Board y verifique que “Arduino/Genuino UNO” esté seleccionada. 

 

4. Crea un nuevo archivo donde va a estar el código del juego. Vaya a File -> New, 

luego grábelo en File -> Save as.. y póngale un nombre. 

 

5. Descargue y añada las siguientes librerías a la carpeta “Libraries” en My 

Documents -> Arduino: 

 

● AdafruitGFXLibrary: https://github.com/adafruit/Adafruit-GFX-Library 

● RGBMatrixPanel: https://github.com/adafruit/RGB-matrix-Panel 

 

6. Copie el siguiente código en su nuevo archivo: 

 

// Añadiendo las librerias existentes al código 
#include <Wire.h> 
#include "Adafruit_LEDBackpack.h" 
#include "Adafruit_GFX.h" 
 
 
// Asignando los pines 
int PB = 7; 
 
int s1 = 8; 
int s2 = 9; 
int s3 = 10; 

https://www.arduino.cc/en/Main/Software
https://www.arduino.cc/en/Main/Software
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int s4 = 11; 
int s5 = 12; 
 
 
// Creando una nueva instancia de las clases encontradas en las librerias 
Adafruit_7segment scoreDisplay = Adafruit_7segment(); 
Adafruit_7segment timerDisplay = Adafruit_7segment(); 
 
void setup() { 
 

  // Asignando los modos iniciales de los pines 
  pinMode(PB, INPUT); 
  pinMode(s1, INPUT_PULLUP); 
  pinMode(s2, INPUT_PULLUP); 
  pinMode(s3, INPUT_PULLUP); 
  pinMode(s4, INPUT_PULLUP); 
  pinMode(s5, INPUT_PULLUP); 
 
  // Asignando y configurando la comunicación por medio de IIC 
  scoreDisplay.begin(0x70); 
  timerDisplay.begin(0x71); 

} 
 
void loop() { 

  int score = 0; 
 
  // Utilizado para escribir la puntuación inicial a la pantalla 
  scoreDisplay.print(score, DEC); 
  scoreDisplay.writeDisplay(); 

 
  // Utilizado para escribir el tiempo inicial a la pantalla              

timerDisplay.print(30, DEC); 
  timerDisplay.writeDisplay(); 
 
   
  while(digitalRead(PB) == LOW){ 
    // Verificando si el boton ha sido presionado... 
  } 
  // El boton ha sido presionado... 
 
  // Ciclo del tiempo 
  for(int timer = 30; timer >= 0; timer--){ 

    // Ciclo de cotejos por segundo 
    // Este ciclo verificará una interrupción en el sensor 20 veces cada          

//     segundo 
    for(int i = 0; i < 20; i++){ 
 
      // Condición para una interrupcion en el sensor 1 
      // Coteja si ha ocurrido una interrupción en este sensor 
      if(digitalRead(s1) == LOW){ 
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        score += 10; 
        scoreDisplay.print(score, DEC); 
        scoreDisplay.writeDisplay(); // Escribe en pantalla la puntuación 
      } 
 
      // Condición para una interrupcion en el sensor 2 
      // Coteja si ha ocurrido una interrupción en este sensor 
      else if(digitalRead(s2) == LOW){ 
        score += 25; 
        scoreDisplay.print(score, DEC); 
        scoreDisplay.writeDisplay(); // Escribe en pantalla la puntuación          

} 
 
      // Condición para una interrupcion en el sensor 3 
      // Coteja si ha ocurrido una interrupción en este sensor 
      else if(digitalRead(s3) == LOW){ 
        score += 50; 
        scoreDisplay.print(score, DEC); 
        scoreDisplay.writeDisplay(); // Escribe en pantalla la puntuación 
      } 
 
      // Condición para una interrupcion en el sensor 4 
      // Coteja si ha ocurrido una interrupción en este sensor 
      else if(digitalRead(s4) == LOW){ 
        score += 100; 
        scoreDisplay.print(score, DEC); 
        scoreDisplay.writeDisplay(); // Escribe en pantalla la puntuación 
      } 
 
 
 
      // Condición para una interrupcion en el sensor 5 
      // Coteja si ha ocurrido una interrupción en este sensor 
      else if(digitalRead(s5) == LOW){ 
        score += 100; 
        scoreDisplay.print(score, DEC); 
        scoreDisplay.writeDisplay(); // Escribe en pantalla la puntuación 
      } 
 
      // Esto introduce un retraso de 1 segundo en el ciclo del tiempo 
      // Como este ciclo se ejecuta 20 veces cada 1 vez del ciclo del 

tiempo 
      // 20 * 50ms = 1000ms = 1s 
      delay(50); 
    } 

 
    // Escribe en pantalla el tiempo correspondiente 
    timerDisplay.print(timer, DEC); 
    timerDisplay.writeDisplay(); 
  } 
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  // Escribe en pantalla la puntuación por 5 segundos y luego vuelve a comenzar 
  scoreDisplay.print(score, DEC); 
  scoreDisplay.writeDisplay(); 
  delay(5000); 

} 

 

7. Vuelva a grabarlo en File -> Save. 

 

8. Presione Sketch -> Verify / Compile o CTRL+R para verificar y compilar el 

código. 

 
 

*Nota: Esta série de pasos asumen que el usuario ya ha completado la configuración 

del circuito eléctrico. 
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Galería 
 

 

 

Ilustración 12: Representación gráfica en dibujo 

 
 

 

Ilustración 13: Diseño en tres dimensiones en AutoCAD 
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Ilustración 14: Primer prototipo 

 

 

 

Ilustración 15: Versión final del juego 
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Glosario 
 

C 

Circuitos 
Red electrónica que contiene al menos una trayectoria 

cerrada, 5 

D 

D-Board 
Material eco-amigable hecho de carton utilizado para 

montar el juego, 11, 15 
Diagrama de Bloque 

Representación gráfica de las interfaces a la que el 

sistema se comunica, 9 

E 

Electrónica 
Estudio y aplicación del flujo de electrónes u otras 

partículas cargadas eléctricamente, 5 
Esquemático 

Representación o forma de documentación visual del 

diseño de algún sistema, 8 

I 

IDE 
Acrónimo en ingles para entorno de desarrollo 

integrado y es un programa que contiene las 

funciones y herramientas básicas para el 

programador, 20 
IIC 

Método o protocolo de comunicación bidireccional 

utilizado en sistemas embebidos, 19 

M 

Microcontrolador 

Circuito integrado que incluye las unidades funcionales 

de una computadora. En otras palabras, una 

computadora en un circuito integrado, 16, 19 

O 

Ohmios 
Unidad de resistencia eléctrica. Mide la oposición que 

encuentra la corriente eléctrica para recorrer una 

trayectoria, 16 

P 

Programación 
Proceso de diseñar, codificar, depurar y mantener el 

código de programas computacionales, 5 

R 

Resistor 
Componente eléctrico pasivo de dos terminales 

(positivo y negativo) que implementa resistencia 

eléctrica en un circuito, 16 

S 

Sistemas integrados 
Es un sistema de computadora de propósito especial 

diseñado para llevar a cabo una función específica, 5 
Skeeball 

Juego que consiste en rodar una bola por una rampa 

con el propósito de que caiga en unas aperturas en 

específicas, 6 
Soldadura 

Proceso de unión entre metales por la aplicación de 

calor, 19 
STEM 

Acrónimo en inglés para designar áreas de la ciencia, 

tecnología, ingeniería y matemáticas., 5 
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